BOARD FEATURES

- Complete Power Tree from Input Hot Swap to Point-of-Load
- Hot Swap Controller for Input Power Safety and Telemetry (LTC®4281)
- Intermediate Bus Controller for Precise, Complete Power Control Over Two Separate Buses (LTC3886)
- Point-of-Load Managers/Controllers Cooperatively Sequence, Manage, Measure, and Manage Faults on All Output Supplies (LTC2975 and LTC3887)
- Built-In Load Step Generator for Transient Response Tuning
- I²C/SMBus/PMBus Compatible Interface for Complete Control and Read Back of Telemetry, Including Voltages, Currents, and Temperatures, as well as Status and Faults
- LTpowerPlay® PC GUI Software
- Linduino Firmware Platform Support
- Powered from 12V/1A Wall Supply

Table 1. DC2578A Board Parameters

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>MIN</th>
<th>TYP</th>
<th>MAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>V_IN</td>
<td>11V</td>
<td>12V</td>
<td>13.8V</td>
</tr>
<tr>
<td>Output Power (Total Over All Outputs)</td>
<td>10W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ambient Temperature</td>
<td>0°C</td>
<td>25°C</td>
<td>60°C</td>
</tr>
</tbody>
</table>

Design files for this circuit board are available at [http://www.linear.com/demo/DC2578A](http://www.linear.com/demo/DC2578A)

All registered trademarks and trademarks are the property of their respective owners.

Figure 1. DC2578A Power Tree
DESCRIPTION

The DC2578A is a complete power chain, including a hot swap controller, an intermediate bus controller, and six point-of-load channels with power system management. The board demonstrates how to safely transfer power from a backplane, through an LTC4281 hot swap controller, through an LTC3886 step-down intermediate bus controller (IBC), and out through the point-of-load converters (POLs) that regulate load voltages. It shows the comprehensive set of power management, cooperation, and safety features of the Analog Devices solution, and showcases how easy it is to configure and manage the whole power hierarchy. Each regulated supply has the ability to sequence, trim, margin, supervise, measure, respond cooperatively to faults, and log fault information in nonvolatile memory. In addition, the onboard load pulser helps with optimizing the adjustable LTC3886 control loop response. The rich set of status and telemetry information provided by the entire system is consolidated and presented under one GUI interface — LTpowerPlay.

Table 2. Channel Capabilities

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>HOT SWAP</th>
<th>IBV_8V, IBV_5V</th>
<th>CH0, CH1</th>
<th>CH2 TO CH5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager/Controller</td>
<td>LTC4281</td>
<td>LTC3886</td>
<td>LTC3887</td>
<td>LTC2975</td>
</tr>
<tr>
<td>Nominal Channel Output Voltage</td>
<td>12V, VOUT = VIN</td>
<td>8V, 5V (Defined by Config)</td>
<td>2.5V, 2V (Defined by Config)</td>
<td>1.8V, 1.5V, 1.2V, 1V</td>
</tr>
<tr>
<td>Configured Voltage Trim Range</td>
<td>N/A</td>
<td>±5%</td>
<td>±5%</td>
<td>±5%</td>
</tr>
<tr>
<td>Output Current Limit (Configured)</td>
<td>1A</td>
<td>4A</td>
<td>2.5A</td>
<td>2A</td>
</tr>
<tr>
<td>Load Pulser Current</td>
<td>N/A</td>
<td>1A on IBV_8V</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Temperature Monitor</td>
<td>N/A</td>
<td>1 Internal, 2 External*</td>
<td>1 Internal, 2 External*</td>
<td>1 Internal, 4 External*</td>
</tr>
</tbody>
</table>

*External temperature sensors are located near each inductor.
IC FEATURES

LTC4281
- Allows Safe Board Insertion into Live Backplane
- MOSFET Power Limiting with Current Foldback
- Programmable Current Limit with 2% Accuracy
- Input Overvoltage/Undervoltage Protection
- Monitor Current, Voltage, Power, Energy, and FET Health
- 16-Bit ADC with ±0.7% Total Unadjusted Error
- Wide Operating Voltage Range: 2.9V to 33V
- Internal EEPROM for Nonvolatile Configuration

LTC3886
- Sequence and Trim Supplies to within ±0.5% of Target
- Programmable Voltage, Current Limit, Digital Soft-Start/Stop, Sequencing, Margining, OV/UV/OC Limits, Frequency, and Control Loop Compensation
- Telemetry Read Back Includes Accurate $V_{\text{IN}}$, $I_{\text{IN}}$, $V_{\text{OUT}}$, $I_{\text{OUT}}$, Temperature and Faults per Channel
- PMBus/$I^2C$ Compliant Serial Interface
- Internal EEPROM and Fault Logging
- Automatically Coordinate Sequencing and Fault Management Across Multiple ADI PSM Devices
- Integrated N-Channel MOSFET Gate Drivers
- $V_{\text{IN}}$ Range: 4.5V to 60V; $V_{\text{OUT}}$ Range: 0.5V to 13.8V

LTC2975
- Sequence and Trim Supplies to within ±0.25% of Target
- Programmable Voltage, Current Limit, Digital Soft-Start/Stop, Sequencing, Margining, and OV/UV/OC Limits
- Telemetry Read Back Includes Accurate $V_{\text{IN}}$, $I_{\text{IN}}$, $V_{\text{OUT}}$, $I_{\text{OUT}}$, Temperature and Faults per Channel
- Fast OV/UV and OC Supervisors per Channel
- PMBus/$I^2C$ Compliant Serial Interface
- Automatically Coordinate Sequencing and Fault Management Across Multiple ADI PSM Devices
- Automatic Fault Logging to Internal EEPROM
- $V_{\text{IN}}$ Range: 3.3V, or 4.5V to 15V

LTC3887
- Sequence and Trim Supplies to within ±0.5% of Target
- Programmable Voltage, Current Limit, Digital Soft-Start/Stop, Sequencing, Margining, OV/UV/OC Limits, and Frequency Synchronization
- Telemetry Read Back Includes Accurate $V_{\text{IN}}$, $I_{\text{IN}}$, $V_{\text{OUT}}$, $I_{\text{OUT}}$, Temperature and Faults per Channel
- PMBus/$I^2C$ Compliant Serial Interface
- Internal EEPROM and Fault Logging
- Automatically Coordinate Sequencing and Fault Management Across Multiple ADI PSM Devices
- Integrated N-Channel MOSFET Gate Drivers
- $V_{\text{IN}}$ Range: 4.5V to 24V; $V_{\text{OUT}}$ Range: 0.5V to 5.5V

The DC2578A board is supported by the LTpowerPlay graphical user interface (GUI), which demonstrates the complete set of control and telemetry registers in each IC. The entire system can be controlled and observed in real time through the LTpowerPlay GUI. LTpowerPlay makes it easy to see and control all of the behaviors in the system, to update EEPROM registers, to measure and visualize telemetry from the ICs, to debug any problems that arise, and to store configuration information on the Windows PC for use later.
DEMO MANUAL DC2578A

DC2578A BOARD STRUCTURE

Refer to Figure 1.

HOT SWAP INPUT

The DC2578A represents a typical power chain similar to a plug-in card or industrial scenario where the primary power distribution bus is at a high voltage, and must be processed down to a level and quality factor suitable for the loads. In such a system the bus voltage might be 28V or higher, which is much too high for most loads, and which presents challenging plug-in and unplug conditions. A hot swap controller is the first mechanism to control potentially hazardous voltages and currents in this environment. On the DC2578A board, the hot swap is an LTC4281, which controls and monitors the 12V input supply voltage and current, and manages the health of the FET.

INTERMEDIATE BUS

In many scenarios the high voltage input bus is not suitable to apply directly to the down-stream point-of-load (POL) controllers. The voltage may be too high, too noisy, or too unpredictable, so an intermediate bus controller stands between the hot swap and the POLs, providing a first level of voltage conditioning. On this board the LTC3886 controls two separate intermediate buses, one 8V and the other 5V, which power the down-stream supplies and which can be coordinated through the LTC3886’s timing and fault response mechanisms.

POINT-OF-LOAD CONTROL

After the intermediate bus, the point-of-load controllers provide the final step-down and signal conditioning step to supply clean, predictable power to each load at its preferred voltage. The job of each POL is to power and protect its load.

There are two classes of POL on this board: a power-supply controller (LTC3887) and a 4-channel switching supply (LTC3370) with a power-supply manager (LTC2975). The power-supply controller is a switching regulator with power-system management (PSM) features built-in. It has built-in gate drivers and can monitor and control its output voltages and currents in real time. The

Figure 3. DC2578A with DC1613
DEMO MANUAL DC2578A

DC2578A BOARD STRUCTURE

power-supply manager, on the other hand, wraps around any power supply and provides PSM features such as enhanced accuracy, control, telemetry monitoring, and fault response. On this board, the LTC2975 manages a 4-channel LTC3370 switching regulator.

Note that all of the voltages and currents on the DC2578A board are for demonstration purposes and not inherent limits of the LTC4281, the LTC3886, the LTC3887, or the LTC2975. Input voltages as high as 33V are possible with the LTC4281 and as high as 60V for the LTC3886. Much higher and more flexible voltages and currents are achievable as required by each system. See the individual device data sheets for complete details.

GETTING STARTED

POWERING THE BOARD

Begin with 12V power. Plug in a supply rated for at least 12W (1A) to the J2 connector, or clip to the 12V IN and GND leads. The green LED near the 12V turret will illuminate when power is applied. Also at power-up, an auxiliary keep alive 3.3V supply powers the onboard I²C bus.

THE SEQUENCE OF EVENTS

The board is configured to sequence-up autonomously and deliver power to the loads on the CH0 to CH5 output turrets. A combined total of 10W is available at the POL outputs. The associated LEDs light as each output channel powers up in sequence. There is a lot going on during power-up, so let’s take a look at the sequence.

(1) When the LTC4281 hot swap controller receives power, it automatically begins the sequence of events. On this board, the LTC4281 is enabled by default, so it begins charging the capacitors at a (configurable) measured rate, preventing excessive inrush current from collapsing the 12V input supply. The LTC4281 monitors the inrush current and the input and output voltages, as well as the health of the FET, maintaining power if all system parameters are within programmed limits and the FET is healthy.

(2) When the hot swap output voltage rises above the VIN_ON input threshold of the LTC3886, and the LTC3886 is finished with its boot up from EEPROM, the two intermediate buses begin their sequence. The LTC3886 has two independent outputs, one programmed to operate at 8V and one at 5V. On this demo board, the LTC3886 sequencer is programmed to bring up the 8V rail at the

Figure 4. DC2578A Power Sequence

Figure 5. Hot Swap Voltage Ramp
same time as the 5V rail. Because these two rails are intended to operate in tandem their sequence spacing must be nearly coincident in order to maintain sequencing coherence between the two intermediate power domains.

The scope trace in Figure 6 shows the hot swap (yellow), the 8V (blue) and 5V (green) intermediate buses, and one of the loads (pink) as the systems powers up.

Sequence timing at the loads is coordinated between the LTC2975 and the LTC3887 with the SHARE_CLK signal, which sets the TIME = 0 moment at which both ICs agree that they are ready and can begin sequencing. The LTC3886 intermediate bus controller does not share SHARE_CLK, and the LTC4281 does not have such a signal, so timing of up-stream events is independent.

Once powered up, each output channel can source up to 1A to its load, and will generate a fault under excessive load current. Both the LTC3887 and the LTC2975 maintain better than 0.5% accuracy at their respective outputs, accurately measure current in their output channels, and can respond to overcurrent with programmable fault responses. The LTC3887 and LTC2975 can also coordinate their fault responses so that CH0 to CH5 all respond appropriately in response to any fault.

Each regulator output has its own turret to make access easy. The POL output turrets are located on the upper and lower right hand side of the board, the two intermediate bus outputs are located in the center of the board, labeled IBV_5V and IBV_8V, and the hot swap turret is located center left. Each turret has an associated green LED to indicate when the corresponding power supply is active.
DC2578A BUTTONS AND FUNCTIONS

The DC2578A can demonstrate many important features of the ICs onboard. There are several pushbuttons to activate these features.

4281 DISABLE BUTTON

The LTC4281 on this board is enabled by default, so it powers up the FET as soon as 12V input power is good. To momentarily disable the LTC4281 press the button labeled 4281 DISABLE (Figure 8) which commands the LTC4281 hot swap to shut down its FET. Pressing this button will momentarily interrupt power to everything downstream of the hot swap. When powering down, the down-stream LTC3886, LTC2975, and LTC3887 will not communicate over the I2C bus. Only the LTC4281 will communicate. The LTC3886, LTC2975, and LTC3887 are configured to only communicate when they have VIN power available. Since the hot swap removes this power, no communication is possible.

The green LED near the hot swap turret illuminates when the LTC4281 PGOOD output is active.

The red MOS STRESS LED may illuminate briefly when the 4281 FAULT button is pressed. This indicates that the LTC4281 has detected the event and is responding appropriately. Press the 4281 DISABLE button momentarily to re-enable after a hot swap fault.

4281 FAULT BUTTON

The LTC4281 constantly monitors the FET for any conditions that may cause damage, including a short that pulls down on the gate. The button labeled 4281 FAULT (Figure 9) simulates a FET bad fault for the LTC4281. Pressing this button momentarily pulls down the FET gate through a resistor to GND. In response the hot swap controller turns off the FET and latches off, since retrying with a bad FET could be damaging. The LTC4281 is programmable to respond to other faults as well, such as voltage and current faults by turning off and retrying after a cooldown delay.

The red MOS STRESS LED may illuminate briefly when the 4281 FAULT button is pressed. This indicates that the LTC4281 has detected the event and is responding appropriately. Press the 4281 DISABLE button momentarily to re-enable after a hot swap fault.

POL DISABLE BUTTON

The LTC3887 and LTC2975 share a common control input that commands them to turn on their outputs. Normally this signal pulls high as soon as the intermediate buses power up. Pressing the POL DISABLE button (Figure 10) momentarily disrupts this control signal and causes all of the POL outputs to sequence down in a coordinated fashion. The hot swap and intermediate buses remain up.
DC2578A BUTTONS AND FUNCTIONS

The pin labeled RUN in the header at the bottom of the board carries this same signal, which can be monitored or pulled low at the pin.

CREATE FAULT BUTTON

All of the PSM ICs on this demo board monitor for faults and have programmable fault responses. The button labeled CREATE FAULT (Figure 11) produces an under-voltage fault on CH2 at the load, causing the LTC2975 to respond according to its programmed fault response, bringing down all of its controlled channels (CH2 to CH5), then restarting them when the fault button is released and the fault is gone. This behavior is configurable, including fault responses and fault sharing between the LTC2975 and LTC3887.

LOAD PULSE JUMPER

The LTC3886 has a set of special loop stability tuning features that allow the user to change the gain, resistance, and $g_m$ components of the control loop. This makes it quite flexible, but also requires some tuning to optimize the loop response. To make the loop response more observable the DC2578 board contains a load pulser that can step a controlled load current on the 8V intermediate bus, causing the LTC3886 to exhibit its step response.

Enable this load pulser by setting the LOAD PULSE jumper (Figure 12) to the ON position. An LTC6992-2 Timerblox IC generates a repetitive pulse train that periodically pulses the gates of three MOSFETs loading the IBV_8V bus, forcing 1A total load current pulses from IBV_8V to GND.

As we will see later, the load pulser makes it easy to observe the load transient response on the IBV_8V turret while adjusting the loop stability parameters in the LTC3886. The LTC3886 data sheet contains a helpful section called PROGRAMMABLE LOOP COMPENSATION that explains the circuit and how to estimate loop bandwidth and phase margin by measuring the voltage at the at the ITH pin. On the DC2578A board this is the voltage across C17 near the LTC3886 in the center of the board. A similar transient, like Figure 13, can be more easily observed at the voltage on the IBV_8V turret in the center of the board. Also, see Application Note 170.
DC2578A BUTTONS AND FUNCTIONS

THE I2C/SMBUS/PMBUS

The I2C bus is accessible through the connectors on the left hand side of the board. There are three: the black 14-pin LINDUINO header, the white 12-pin DC1613 header, and the SCL, SDA and ALRT pins. Each of the connectors is buffered to provide bus isolation and acceleration for the heavily loaded SCL and SDA lines.

Use the white DC1613 header to connect a DC1613 dongle and LTpowerPlay to the board. This is the most common use model. The DC1613 dongle provides a connection from a Windows PC running LTpowerPlay that can control and monitor all of the features of the parts on the I2C bus. See the LTpowerPlay section below for more details.

Use the black Linduino connector to attach a DC2026 Linduino and demonstrate the firmware control capabilities of that platform. The Linduino section below gives more details.

Use the SCL, SDA and ALRT header pins to attach other I2C bus masters. These pins are also useful for probing the I2C bus with an oscilloscope or Beagle bus sniffer. One additional, very useful use is to attach a scope probe to the ALRT line, and trigger on a falling edge. This provides a very simple trigger when a fault happens on the board, showing the events taking place directly before and after the fault condition.

Figure 14. LTpowerPlay Graphical User Interface
USING LTpowerPlay TO EXPLORE

The LTpowerPlay GUI is the best way to view and interact with the DC2578 system in real time. The ICs on the board have a rich set of features that are accessible through the I²C/SMBus/PMBus interface, and LTpowerPlay taps into all of these resources, making them visible, clear, and controllable in one place.

You can use LTpowerPlay to evaluate the DC2578A demo board (one of many demo boards available), or connect it to a complete production system through an I²C/SMBus/PMBus bus. It also works in off-line mode to plan and prepare register settings with no board connection at all. Use any of these modes to build a multichip configuration file, then save it to disk so it can be uploaded to a board later. It is a powerful debug tool for use during board bring-up or for diagnosing problems. It can show status and faults in all of the ADI ICs on the bus, as well as record and play back events as they happen, and it can provide live remote support with a helpful support representative. LTpowerPlay keeps itself up-to-date with the latest drivers and documentation through an auto-update feature. You can download LTpowerPlay here:

http://www.linear.com/ltpowerplay

LTpowerPlay talks to the I²C/SMBus/PMBus through the DC1613 dongle, which converts from the USB port on the PC (see Figure 3). Make the connections by plugging in the DC1613 to a USB port on the PC and plug the 12-pin ribbon cable to the DC2578A board at the white header labeled DC1613 on the left side of the board. When LTpowerPlay launches it finds the dongle, then probes the DC2578A board to find the PMBus parts there. For this demonstration system LTpowerPlay automatically loads all of the ICs in the system tree, and the hardware configuration in each one (Figure 14).

LTpowerPlay BASICS

LTpowerPlay is a powerful tool for visualizing what is going on in a system in real time. Here are some of the many features that are available. This is a subset of all available capabilities in LTpowerPlay. Use the Help menu to find more information.

INITIALIZING THE DC2578A BOARD

Begin with the 12V power supply and the DC1613 dongle connected.

When LTpowerPlay first starts and finds the DC2578A board connected to the DC1613 dongle it populates the system tree with all of the I²C ICs on the board: the LTC4281, the LTC3886, the LTC3887, and the LTC2975. It then communicates with each IC at its default address, and loads the register contents from each one into the GUI. Under normal conditions all of the ICs will be powered, and will communicate with LTpowerPlay. In situations where one or more of the ICs is not powered, LTpowerPlay displays demo board default values from a default file. See Figure 15. Under normal circumstances this is all that is necessary, and the user doesn’t need to do any further initialization.

USING A PROJECT FILE

If you make changes to register settings in LTpowerPlay and wish to preserve these settings in a file for later, simply save a project file using the File → Save and File → Open menu items. A project file contains all of the information about the system tree, device addresses, and register configurations.

Save a project file containing the current state of the registers represented in LTpowerPlay using the File → Save... menu and entering an appropriate file location and name.

The default configuration file for the DC2578A board is located here in the LTpowerPlay installation directory:

C:\Program Files (x86)\Linear Technology\LTpowerPlay\demos\democircuits\DC2578A\DC2578A_Defaults.proj

The simplest method to access this default programming file is using the demo menu, by selecting Demo → DC2578A_Defaults. This demo menu loads the file, downloads the register values into the ICs on the board, and commands each IC to store the settings into EEPROM.

1. For complete instructions on programming the DC2578A see Appendix A on Programming at the end of this manual.
USING LTpowerPlay TO EXPLORE

The procedure for loading any new project file into the operating memory of the ICs on the DC2578A board is as follows:

1) File → Open...

2) Select the desired file (it may be in your work area or in the LTpowerPlay installation directory).

3) Press the GO ONLINE button to begin communicating with the I²C bus.

4) Press the PC → RAM button to download the register settings to the ICs on the board.

which can include a problem with a channel (like CH5 in Figure 16), a stored fault log, or simply commanded off with power not good, as with CH0 and CH1 in the figure.

In Figure 17 we see the system tree when the hot swap is communicating over the bus, but not supplying downstream power. All other ICs are off, so not communicating. This is indicated by the red circle icons indicating a device that is not communicating on the bus.

THE SYSTEM TREE

The main visualization of the overall system is the system tree, which shows the status of each IC in the design at a glance. Each power supply device and each channel is represented in the tree. Each device’s type and I²C address is shown, and each channel is labeled with an appropriate name representing its function on the DC2578A board. Select an IC or channel in the system tree by clicking it.

Colors and icons are important in the system tree. Each little square icon is divided into a lower half labeled O for OUTPUT ENABLE, and an upper half labeled S for STATUS. Green means good, and red means fault. Gray means inactive (OFF). Yellow means status warning.
limits the devices shown in the system tree, and also the operations that are performed (such as group operation commands). It is useful to sub-divide the system because the complexity of a multi-tiered power supply makes operating on sub-blocks necessary.

CONFIGURATION REGISTERS

The configuration registers for each IC are accessible in the Config tab (Figure 19). Registers for the selected device or channel in the system tree are displayed here. Note the buttons along the top, which select groups of registers by category, such as Setup, Voltage, Fault Responses, etc.

Change a register value by clicking to select the register and typing the new value. Write the changed register value to the IC register using the shortcut key: F12. Write ALL register values from LTpowerPlay to all ICs using the PC → RAM button in the button bar.
**USING LTpowerPlay TO EXPLORE**

**TELEMETRY, STATUS AND FAULT REGISTERS**

The telemetry tab displays all of the status and fault registers in the selected channel (Figure 20). Available telemetry depends upon which IC and which channel is selected in the system tree. All of this information is updated in real time while LTpowerPlay is actively scanning the I²C bus and the ICs are on line and communicating. Available telemetry from the PSM parts includes input voltage and current, output voltage and current, power, temperature, fault conditions, and historical values.

**TELEMETRY PLOT**

The telemetry plot shows a graphical timeline of the selected sampled telemetry for all available ICs in the system, similar to a slow-motion oscilloscope trace (Figure 21). For the PMBus devices, which share a common set of commands (like READ_VOUT), all available similar telemetry for all PMBus ICs in the system is represented on one plot. The LTC4281 is the only device of its kind on the bus, and it does not support PMBus commands, so when it is selected only a single register is represented on the plot.

---

![Telemetry Registers Tab](image1)

![Telemetry Plot](image2)

**Figure 20. Telemetry Registers Tab**

**Figure 21. Telemetry Plot**
IDEALIZED WAVEFORMS

The idealized On/Off waveforms tab shows idealized timing information for all channels in the system, based upon how the ICs are programmed to sequence up and down. The data is representative of the on and off delays, the ramp times (where applicable), and the voltage levels for each channel. This is a very easy way to visualize the real sequencing behavior of the whole system (Figure 22).

FAULT WARN LIST

The FAULT_WARN_LIST tab collects a complete set of fault and warning indicators for all of the PMBus ICs in the system (or in the currently selected group in the system tree). It is a virtual register representation at the level of each IC, displaying all of these virtual registers collected into one easy to read location under the FAULT_WARN_LIST aggregation tab.

Simply select the FAULT_WARN_LIST register in the status summary section of the telemetry tab of any chip in the system. This virtual register in the telemetry tab shows fault and warning status for the currently selected chip. Concurrently, the aggregation tab displays all of the FAULT_WARN_LIST registers for all chips in the system tree. This is a powerful way to quickly determine where there are faults and warnings in the system without needing to click through many registers (Figure 23).
SEQUENCING

The DC2578A board is somewhat unique among demo systems in that it contains a complete hierarchy of power-handling capabilities. Because of this structure, it requires special sequencing that simpler boards do not. This uniqueness is a virtue because it demonstrates how powerful all of the Analog Devices power management ICs are when they work together seamlessly. We will revisit the sequencing operations here, focusing on the LTpowerPlay features that affect it.

All of the ICs on the demo board are programmed to autonomously start delivering power down stream as soon as they can. The LTC4281 detects a good input voltage and turns on the pass FET. The LTC3886 detects its input voltage and generates the two intermediate bus voltages. The LTC3887 and LTC2975 both detect that their input voltages are good and enable their outputs cooperatively in the programmed sequence. Any chip in the system that is not powered may show in LTpowerPlay as a red circle because it does not communicate on the I2C bus (Figure 24). This flow of power is required by the design, so it is not programmable. There are, however, many programmable features at each step in the process.

LTC4281 HOT SWAP POWER-UP

The LTC4281 is primarily an input control device. It measures input voltage, current, and FET health, and reports all of its status and telemetry on the I2C bus. During sequencing it limits the current allowed to flow through the FET by measuring it and actively controlling the FET gate when current is too large. The maximum allowed current is programmed as the voltage across the sense resistor, set in the ILIM_ADJUST register. During power-up the inrush current is limited to 30% of the ILIM_ADJUST current while V(SOURCE) is below 1.3V (the voltage across the FET is large).

To control the allowable current, change the value of the ILIM_ADJUST register. We can see the effect of changing the value of the ILIM_ADJUST current on the power-up behavior in Figure 25. Here three different ILIM_ADJUST values were used, resulting in three different ramp-up times. The value of the FOLDBACK_MODE setting also affects the ramp behavior to limit current more aggressively for larger input voltages.

Once power is up, the LTC4281 actively enforces the ILIM_ADJUST current limit by actively regulating the FET gate when current exceeds the limit. This current clamp can prevent down-stream devices from pulling too much current, and in the event of overcurrent, the voltage will droop as the FET current limits.

Figure 24. Partially-Sequenced System Tree

Figure 25. Hot Swap Ramp with Three Different Current Limit Settings
SEQUENCING

Control the LTC4281 directly on the DC2578A board by pressing the 4281 DISABLE pushbutton. This turns off the device and powers down the entire board. This is also an effective reset for all of the ICs when their power is removed. This is equivalent to toggling the FET_ON bit in the CONTROL register of the LTC4281 (Figure 26).

This timing is programmed by several registers in the LTC3886. The VIN_ON and VIN_OFF configuration registers command the voltages at which the LTC3886 recognizes its input as high enough to begin operation (Figure 27).

Once the sequencer begins operating, it honors the TON_DELAY and TON_RISE configuration registers. In the scope shot in Figure 28 we see that both the IBV_8V and IBV_5V buses rise approximately 155ms after the 12V hot swap voltage rises. The delay from the hot swap rising includes approximately 55ms boot time of the LTC3886, but the remaining 100ms is commanded by the TON_DELAY register. The two intermediate buses must sequence up and down together to properly coordinate the timing of the down-stream point-of-load devices.

Notice that the TON_RISE value is set to 8ms rise time. This is because a fast rise time represents a larger inrush current, and can exceed the current limit in the LTC4281 hot swap, causing a fault. The programmed values on this board are for demonstration, and can be scaled up appropriately for any larger system.
Even though these two POL controllers are on different intermediate buses they can still coordinate their timing and fault responses, managing sequencing from a common \(\text{TIME} = 0\) based upon their shared \(\text{SHARE} \_\text{CLK}\) line, and communicating fault information through their shared \(\text{FAULT}\) line. These two sequencers have \(\text{TON} \_\text{DELAY}\) values that both begin when the two ICs release \(\text{SHARE} \_\text{CLK}\) to begin clocking. This happens when both the LTC3887 and the LTC2975 observe \(\text{VIN}\) values above their respective \(\text{VIN} \_\text{ON}\) settings.

Setting the relative sequence timing of the six POL power supplies is simple. PMBus commands are common between devices, so \(\text{TON} \_\text{DELAY}\), \(\text{TOFF} \_\text{DELAY}\), \(\text{TON} \_\text{RISE}\), \(\text{TON} \_\text{MAX}\), \(\text{TOFF} \_\text{MAX}\), and others, are defined similarly, and can be programmed into each IC so that they all cooperate during sequencing. On the DC2578A board the LTC2975 and LTC3887 are programmed to stagger their sequence up events every 100ms, starting with CH2, and CH3, then CH0, and proceeding left to right (Figure 30). The sequence is completely configurable, as is the independent down sequence.

Notice that the idealized waveforms tab maintains a visual representation of the relative sequence timing between all of the channels as they are configured. This view is accurate to the extent that the register values are representative. Remember, however, that while the system is powering up, you may observe additional delays due to boot up time in the ICs.

LtPowerPlay can address several ICs simultaneously using grouped PMBus commands. This is convenient in cases like margining the power supplies or simultaneous sequencing. Select the group OP button to activate the group OP window (Figure 31). The buttons in this window allow you to conveniently command sequencing or margining operations for all of the ICs currently visible in the system tree. If you have selected a sub-group in the system tree, such as the POINT-OF-LOAD group, only that sub-group will receive the group commands. This is important in cases when power is not applied to the entire power tree, so some ICs will not respond to bus commands.

Selecting the POINT-OF-LOAD group in the system tree tab limits the operation to the LTC2975 and LTC3887 devices. Clicking the Margin High group operation causes all of the POL supplies to ramp to their predefined \(\text{VOUT} \_\text{MARGIN} \_\text{HIGH}\) voltages, as defined in each channel's configuration (Figure 32). The DC2578A board configuration sets margin excursions to ±5%. Clicking the On group operation button returns the voltages to their
nominal settings (Figure 33). The servo mechanisms in the LTC3886, LTC3887, and LTC2975 accurately control the voltages to within 0.5% of their target values.

**LTC3886 TRANSIENT RESPONSE**

The LTC3886 has programmable loop compensation through two registers that allow the user to adjust the control loop $g_m$ and resistance to move the loop gain and pole locations without changing any hardware. The LTC3886 PWM\_COMP register contains settings for both of these values.
SEQUENCING

The DC2578A has an onboard load pulse circuit for stimulating the IBV_8V channel of the LTC3886 by pulsing a 1A load current to GND repeatedly. This causes the IBV_8V channel to respond with its step response that can be easily observed on an oscilloscope. To observe and adjust the transient response:

1) Move the LOAD PULSE jumper to ON.
2) Connect a scope probe to the IBV_8V turret.
3) Set the probe to 100mV/div, 100µs/div, AC coupled.
4) Modify the values of EA_GM and R_TH in the MFR_PWM_COMP register of the LTC3886 control.
5) Observe that you can drive the loop between instability and well-damped response simply by adjusting these registers (Figure 35).
6) Move the LOAD PULSE jumper to OFF when finished.

In Figure 35 we see the voltage step response at IBV_8V for a tuned loop (yellow) and a detuned loop (gray).

Fault Log tool. Access this tool by clicking the FL button in the tool bar. If any PMBus IC in the tree has a stored fault log, the FL button will have a red spot to indicate the presence of fault information.

This button brings up the Fault Log tool, which makes it easy to read and decode the fault log for the IC selected in the System Tree (Figure 36). If there is a stored fault log (indicated in the EEPROM Log Status section), retrieve it by pressing the Read NVM Log button. The decoded contents of the EEPROM fault log appear in the window. This represents the stored ADC readings and status indicators leading up to the time of the fault, in an easy-to-read text format. Clear the EEPROM fault log and re-arm the system by pressing the Clear/Re-arm EEPROM Log button. This will also clear the latched fault state of the RAM registers in the selected IC.

Note that the Fault Log tool is for the LTC3886, LTC3887, and LTC2975 PMBus ICs on the board, which conform to a standard fault log protocol. Accessing the EEPROM fault log in the LTC4281 is handled by directly reading the EEPROM fault and ALERT registers. Refer to the LTC4281 data sheet for full details.

FAULT LOGS

All of the ICs on this board offer a EEPROM black box fault log capability that can store the state of the system at the time that a fault is detected. LTpowerPlay makes it easy to read these fault logs for the PMBus parts with its Fault Log tool. Access this tool by clicking the FL button in the tool bar. If any PMBus IC in the tree has a stored fault log, the FL button will have a red spot to indicate the presence of fault information.

This button brings up the Fault Log tool, which makes it easy to read and decode the fault log for the IC selected in the System Tree (Figure 36). If there is a stored fault log (indicated in the EEPROM Log Status section), retrieve it by pressing the Read NVM Log button. The decoded contents of the EEPROM fault log appear in the window. This represents the stored ADC readings and status indicators leading up to the time of the fault, in an easy-to-read text format. Clear the EEPROM fault log and re-arm the system by pressing the Clear/Re-arm EEPROM Log button. This will also clear the latched fault state of the RAM registers in the selected IC.

Note that the Fault Log tool is for the LTC3886, LTC3887, and LTC2975 PMBus ICs on the board, which conform to a standard fault log protocol. Accessing the EEPROM fault log in the LTC4281 is handled by directly reading the EEPROM fault and ALERT registers. Refer to the LTC4281 data sheet for full details.
LINDUINO AND FIRMWARE CODE

The DC2578A is supported by the Linduino microcontroller platform, which is an Arduino-compatible microcontroller, programmed in C and C++. The Linduino code library provides a thorough set of sample code demonstrating the best practices for communicating with and controlling the ADI ICs on the board. If you have the latest Linduino development environment and the sketchbook code installed, then you will be able to use the Linduino to talk to the DC2578A on the I²C/SMBus/PMBus, controlling all of the functions and features of the LTC4281, the LTC3886, the LTC2975, and the LTC3887 on the board. The Linduino code gives practical examples of how to use the extensive PMBus and SMBus libraries to access the devices.

See the Linduino web site, and the DC2026 demo manual for instructions on getting started with the Linduino platform:

http://www.linear.com/solutions/linduino

Once you have a working Linduino and the latest LTSketchbook code library, simply select the DC2578A.ino sketch from the sketchbook and upload it to your Linduino.

File → Sketchbook → User Contributed → DC2578A → DC2578A

You may control many of the features of the DC2578A demo board by selecting the appropriate menu items in the serial monitor window. Type the menu number and hit ENTER. The Linduino will send the necessary commands over the bus to the demo board (Figure 37).
APPENDIX A: PROGRAMMING

There are many ways to program the very flexible ICs on the DC2578A and there are relatively few ways to get it right, with everything programmed for best performance. In some cases you can get the system into a state of partial power that makes it tough to program, since some of the devices are not powered. This appendix presents the best way to bring the system back to a known-good program state.

Because this board has several layers of power supplies, flowing power from the board input through the hot swap, then through the intermediate buses, and finally to the two cooperating POL managers/controllers, there are many ways to disable power supplies down stream. Disabling down-stream power supplies will prevent one or more of the ICs from communicating on the I2C bus, which will prevent LTpowerPlay from being able to successfully program that device.

The easiest programming technique in LTpowerPlay is to select the demo menu and allow the tool to attempt to program all of the devices on the board at once. Selecting Demo → DC2578A_Defaults instructs the tool to write the RAM contents of all ICs on the board, then burn those RAM values into the EEPROMs for persistent storage. Unfortunately, if one or more of the ICs is not powered, then the process will not succeed. The result may be an incompletely programmed board.

The most general solution to successfully programming in this environment is an iterative approach in which each up-stream device is programmed in order, followed by devices further down stream. The process looks like this:

1) Load the desired project file from disk. The DC2578A_Defaults project file is a safe option:
   C:\Program Files (x86)\Linear Technology\LTpowerPlay\demos\democircuits\DC2578A\DC2578A_Defaults.proj
2) Press the GO ONLINE button to activate communication with the board.

3) Note the group labels at the top of the system tree tab: All, HOT SWAP, INTERMEDIATE BUS, and POINT-OF-LOAD groups should be available. Select the HOT SWAP group. Note that if you create your own project file you may need to create your own groups using the Edit Groups... tool.

4) Press the Write to RAM button on the tool bar. This will write correct values to the hot swap IC, instructing it to enable its output.

5) Select the INTERMEDIATE BUS group next. Press Write to RAM. This programs the LTC3886, activating the IBV_8V and IBV_5V rails which power the LTC3887 and LTC2875.

6) Select the POINT-OF-LOAD group. Press Write to RAM. This programs the LTC3887 and LTC2975 ICs. At this point all of the rails should be active, and all of the ICs should be correctly programmed.

7) Store RAM contents to EEPROM by pressing the Write to EEPROM button.
APPENDIX A: PROGRAMMING

8) Verify the contents of all ICs by selecting the All group and pressing the VERIFY button in the toolbar.

If the Verification process indicates problems, repeat the process for the offending ICs. Since every part of the system should now have power it is not necessary to use the sub-groups during programming, but it may be helpful to isolate specific elements of the system.

There are additional resources on the web to help with advanced programming topics. These documents include I²C/SMBus/PMBus addressing for Analog Devices devices:


Programming directly through in-flight update:


EEPROM structure in Analog Devices PSM devices:

APPENDIX B: SCHEMATICS
Information furnished by Analog Devices is believed to be accurate and reliable. However, no responsibility is assumed by Analog Devices for its use, nor for any infringements of patents or other rights of third parties that may result from its use. Specifications subject to change without notice. No license is granted by implication or otherwise under any patent or patent rights of Analog Devices.
ESD Caution

ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. (“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term “Third Party” includes any entity other than ADI. Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, WARRANTIES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable United States federal laws and regulations relating to exports. GOVERNING LAW This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.